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The Toledo PC Users’ Group
P.O.Box 13085
Toledo OH 43613

Officers

President: Floyd Miller........ 419 536-6738
fimiller@toltbbs.com

Vice-President: Roy Ballogg..419 726-5898
roybean@toltbbs.com

Secretary: Sandor Halasz
hsv@toltbbs.com

Treasurer: Steve Tryc............ 419 865-3221
stryc@toltbbs.com

Standing Committees

Computer Shows: Steve Tryc....419 865-3221

Librarian: Open

Membership: Lester Miller.......419 865 6223
lest77marthm@buckeye-access.com

Programs: Lester Miller (see above)

Public Relations: Lavern & EugeneCurtis
Newsletter: Nina Sherman...... 419 726-2283
nsherma@buckeye-express.com
Complaint Dept........ccccceevveivennnns Helen Waite

SIG Leaders
Internet SIG: Jim Bell 419 877-1109

Statement of Intent: The Toledo PC Users’
Group is a not-for-profit corporation, formed to
provide a forum for the exchange of ideas and in-
formation regarding the use and enjoyment of per-
sonal computers.

Affiliations: TPCUG is a member of APCUG
(Association of Personal Computer User Groups)
which provided the APCUG Logo.

Meetings: Meetings are generally held the first
Monday of each month, at the UAW Local 14 Hall,
5411 Jackman Rd., Toledo OH. In the event of
emergency, mambers may be reached during meet-
ings at a pay phone in the hall, 419 473-9571.

Visitors are always welcome at monthly meetings!
Executive Board Meetings will generally be held
after the regular meeting.

Membership: Dues are $25. per year. To obtain
application, call any officer or member.

Moving? Notify the Membership Chairman to
redirect your newsletters.

Copyright, 2004: The Toledo PC Users’ Group,
the publisher of this newsletter, is a not-for-profit
organization. Although it asserts a copyright for
the newsletter, permission is granted to reprint this
publication in whole or in part for any non-com-
mercial use, with credits acknowledged.

Newsletter Deadline: is the 15th of each month.
All members are encouraged to contribute articles
and reviews for this newsletter. Submissions may
be made by E-mail or submitted by floppy or CD
in ASCII or other acceptable format at the meet-
ings, e-mail or by snailmail. (Please contact edi-
tor.)

Advertising:
Business cards (2 x 3-1/2”) $5. for 3 issues

Commercial ads: 1/4 page - $10. “

“ 1/2 page - $20. *“

“ 3/4 page - $30.  “

“ Full page - $40. “
Larger ads will be run in two issues, and should be
a graphics format such as jpeg or tif, or camera
ready copy. Members may place free ads for the
sale of computer related personal items on a space
available basis. Contact editor for details.

Production Notes: This newsletter was compiled
in Adobe Pagemaker7 for Windows and printed on
a HPDeskjet d135.

TPCUG Mailing List: If you’re on the Internet,

keep in touch with Club doings by subscribing to

the TPCUG mailing list: Send e-mail to
tpcug-request@toltbbs.com

with only
subscribetpcugAtoltbbs.com
in the body of the message. You will then receive
communications sent to the list through e-mail.
Send e-mail to:-
who-tpcug@toltbbs.com
to see who else is subscribed to the list.
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President’s Message
Floyd Miller

The following information shows that we
homo sapiens with human brains (excluding
Rush Limbaugh who only uses half his brain)
will have to become much smarter to prevent
our mental abilities being taken over by a chip
of whatever composition.

Chris Nuttall reveals that Semiconductor
designers from IBM, Sony and Toshiba will
reveal the inner workings of a “supercomputer
on a chip” they claim could revolutionize
communications, multimedia and consumer
electronics. Products containing Cell including
Sony’s PlayStation 3 games console are
expected as early as next year.

Advance reports suggest the chip is
significantly more powerful and versatile than
the next generation of micro-processors
announced by the consortium’s competitors,
Intel and AMD. The two leading chip makers
are just moving from 32-bit to 64-bit
computing and to dual-core processors
essentially two “brains” on a single chip.Cell is
understood to have at least four cores and be
significantly faster than Intel and AMD chips.

“This is probably going to be one of the
biggest industry announcements in many
years,” said Richard Doherty, president of the
Envisioneering research firm. “It’s going to
breathe new life into the industry and trigger
fresh competition.” Cell is being presented as
an architecture capable of wide-ranging
functions and powerful parallel processing that
will allow it to distribute its work among the
different cores in order to perform many tasks
at once.

The consortium says this will improve the
quality of video delivered over the broadband
internet and increase the fidelity of computer
games. High-definition TVs from Sony and
Toshiba, a Sony home server for broadband
content and the PlayStation 3 all featuring Cell
are due to appear in 2006. Cell’s architecture is

described as scalable from “small consumer
devices to massive supercomputers” IBM is
expected to begin

pilot production of the Cell chip in the first
half of this year. Oh well, I don’t want to
work that hard any more — let the darn
thing take over for me {;-) }

Now back to the reality of the moment we
need to discuss a major change that is in
process for the publishing of the Group’s
Newsletter. Given our financial resources
and lack of opportunities to supplement
income from membership dues, we have
decided to make the news letter available on
line. This will eliminate printing costs as
well as postage costs. Nina Sherman is in
agreement with this change and has already
mastered Adobe Acrobat to create the news
letter as a PDF document which will make it
easy to publish as a page on our web site. If
you have only e-mail capabilities perhaps we
can make it available to your e-mail address.

Before we reach the end of your attention
span and your ability to assimilate
information, we merely say Visitors are
Welcome - Members are expected.
Respectfully submitted,

Floyd L. Miller, Your Prez

Subject: Treasurers report

Balance Ending 1/10/05 $1,590.45

Income

2 renewals , Shepard, Tenney 50.00

1 new member, Barocsi 25.00
Total 75.00

Expense

Feb. Newsletter 51.67

Balance Ending 2/14/05 $1,613.67
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Secretary’s Minutes of the
February 2005 Meeting

After Joe Bassett’s talk, at 21:12 the
meeting was called to order by Floyd Miller,
president.

The minutes, printed in the newsletter,
were accepted.

The treasurer s report was accepted,
subject to audit.

There were 14 present, and one newcomer.

Queen Ink was invited for next month. (F.
Miller passed this on in L. Miller s absence).

The Internet SIG meets in Whitehouse, on
the third Monday at 7ish. A crowd to go in
one car meets at Asbury Church at 6:30ish.

Old bizness:

To ease the burden of printing & mailing
the newsletter, Roy Ballogg moved that it be
sent to the membership in PDF through
email from the group “tpcug” kept at TBBS;
it was seconded but not passed. Sandor
Haldsz moved that it be kept at TBBS on
the club’s website, whence the membership
may read it; it was seconded and passed.

New bizness:

Al Zohn s wife died; let the secretary send
a condolence-card.

The meeting was adjourned at 21:47
Sandor Halasz, Secretary

Online Tip of the Day - from Smart
Computing Magazine,

February 18, 2005

(Reprinted with permission from Smart
Computing Magazine)

What Really Gets Restored During A
‘System Restore’?

Microsoft designed System Restore to fix
unexpected system-level problems that can
arise from the aforementioned events or other
errors that result in system failure. At the same
time, the company built the program to protect
your personal data from being accidentally
deleted when you roll things back. When you
run System Restore, the following changes and
repairs are made:

OnlineTip of the Day: February 19, 2005
Use Msconfig to Boot Into Safe Mode

(Reprinted with permission from Smart
Computing Magazine.)

One of the best ways to troubleshoot errors or
remove a problematic driver is to boot
Windows without loading any special drivers or
programs, and most of us resort to hitting that
F8 key at just the right second in the boot
sequence to flip Windows into Safe Mode.

There’s an easier way. The much-ignored
System Configuration Utility can force your
system to reboot with only generic drivers.

From the Start menu, select Run, type
msconfig in the Open field, and click OK. In
the General tab of the System Configuration
Utility, check the radio button Diagnostic
Startup, which will start Windows without the
major drivers and startup programs. Click OK
and you are prompted to reboot. When you are
ready to boot in normal mode, open the utility
and check the Normal Startup radio button.

Don’t forget, when troubleshooting a
problem, use the Startup tab in this tool, which
shows you which programs are loading into
memory at startup. By unchecking specific
programs, you can prevent them from loading at
boot. This is a great way to eliminate some of
the irritating resource hogs that some programs
insist upon installing in your system. It is also
the first place to look for spyware, which often
plants itself as a startup program.
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From: marcy-gunn
Sent: Jan 14, 2005 1:10 PM

Subject: Smart Computing User Group
Program

Dear Toledo PC Users Group,

I would like to take this opportunity to
thank the Toledo PC Users Group for taking
part in the Smart Computing User Group
Program. We appreciate your efforts to
bring Smart Computing and our sister
publications to your user group and would
like to reward your group for its
participation! With the Smart Computing
User Group Program, we will reward your
user group with a free 1-year subscription
for every 5 paid subscriptions we receive
from your group! Through the 4 quarter of
2004, the Toledo PC Users Group
accumulated enough credits to earn 1 free
1-year subscription(s) to Smart Computing!

To redeem your group’s free
subscription(s), all you need to do is send
me the name, address, email and phone
number of the person to whom you would
like the subscription sent and | will get
things started up for the lucky recipient as
soon as possible. Simply email or call me
with the information when you have it
ready. For your records, below is the Toledo
Ptg: Users Group’s account activity for the
4" quarter of 2004.

Smart Computing Code Number: 12841
cPU Code Number: 1049pC
Today Code Number: 657

Buy 5 Get 1 Free Program
Credits Carried Over from 3" Quarter of 2004: 0

Credits Earned during 4" Quarter of 2004:
8Total Credits: 8

FREE SUBSCRIPTIONS
EARNED: 1

If you have any questions regarding the
Smart Computing User Group Program or
your group’s free subscription(s), please
feel free to call or email. And don’t forget
about the Smart Computing Start Smart
Giveaway 2005. Get involved today for a
chance to win a presentation by Smart
Computing’s very own Rod Sher. Rod has
been the editor of Smart Computing since
2002 and has been involved with the
technology industry for over 20 years.
Don’t miss your chance to have Rod
come and talk to your group.

Here’s how you can get involved:

1) Place a write-up in your newsletter
about Smart Computing

2) Place a write-up on your group’s
website

3) Place a link to Smart Computing on
your group’s website

4) Book a Presentation with a Smart
Computing Representative

5) Buy a subscription, gift subscription,
or renewal for Smart Computing, PC
Today , or CPU.

Your user group can earn chances to win
by doing one or more of the above items
by March 31st 2005. The more you do the
more chances you’ll have to win. Get
involved today! For more details about
the program, see our note* at the end of
this letter or contact us today at .

I look forward to hearing from you soon!



PC Operating Instructions April
2005 « \Vol.16 Issue 4 Smart Computing
Magazine

Best Burner Ever

It’s sometimes interesting to watch the
evolution of open-source software. Early
software is often difficult to use, as it
requires extra configuration and an in-depth
understanding of what’s going on behind the
scenes. With time, existing applications
improve or entirely new applications raise
the bar. Before you know it, Linux has a
piece of software that can rival anything
found on Windows. K3b, a CD- and DVD-
burning application, is one example.

Reburn Configuring a Linux system to use
a CD/DVD burner used to be a fairly
complex task, and a good GUI-based
application was hard to find. Today, nearly
all Linux distributions automatically detect
and configure a CD or DVD burner during
installation, and K3b is a vast improvement
over older GUIs.

In addition to K3b, you’ll also need cdrecord
and cdrdao. You may already have these
applications installed, but if not, you can
usually find them on your installation media.
If you’re using Debian or another Internet-
based distribution, you should have no
problem finding binary packages for your
distribution. Debian users, for instance, can
install all three applications by typing apt-
get install cdrecord cdrdao k3b at the
command line. (You’ll need root privileges.)

From The Start The first time you load
K3b, it should ask you to confirm your
drive’s maximum write speed. In most cases,
you should just have to click OK. You may
see a warning that cdrecord and cdrdao
require root permissions to run. K3b makes
changing permissions as simple as clicking
the K3Setup2 button (you’ll need to provide
the root password when asked) and clicking
OK to close the K3Setup2 window. You’ll
then see four options: New Audio CD
Project, New Data CD Project, New Data
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DVD Project, and Copy CD.The Audio CD option lets
you burn a music disc that your home or car CD player
can read. The Copy CD option, curiously enough,
creates a copy of an existing CD. The CD and DVD
data options are used for any other type of CD or
DVD. No matter which option you select, the basic
interface is the same. After selecting the type of
project, you’ll see a split window. Files and directories
on your hard drive are in the top portion. Navigate to
the file or directory you want to burn in the upper
section and drag the item to the bottom section. If
you’re making a music CD, you can drag songs into
the proper position. Click the Burn button to burn files
to the CD or DVD.

If you’ve downloaded Linux from the Internet, you’re
probably familiar with 1SO files. These files are a bit-
by-bit snapshot of a CD’s contents and need to be
burned in a specific way. Select either CD or DVD in
the Tools menu and click either Burn CD Image or
Burn DVD Image as appropriate. Click the folder icon
next to the Image To Burn field and select the 1SO file
you want to burn. You can change the options listed if
you want. To burn the file, click Start.

Integration Because K3b is integrated with KDE’s
file manager, there is a second way to burn files. If you
want to burn everything in a folder to a CD or DVD,
you can simply open Konqueror (the KDE file
manager) and right-click the directory. Select Actions
and click Create Data CD With K3b. You can also
select multiple files from within the file manager and
burn them using the same procedure. This method also
works great for ISO files. Simply right-click the 1ISO
file, select Actions, and click Write CD Image With
K3b.

Extras K3b is extremely easy to use, but it also has
a number of advanced options. For instance, you can
select the Encode Video option from the Tools menu.
This is a handy feature if you want to create DVD
videos. For more information about encoding DVDs,
click K3b Handbook in the Help menu. The K3b plug-
in system lets you extend the operating system’s
functionality. For instance, you can add plug-ins for
encoding audio in MP3, Ogg Vorbis, or other audio
formats. You can also choose from more advanced
projects by selecting New in the File menu. by Chad
Denton

(The above article was reprinted by permission
from Smart Computing Magazine)



